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1 Overview 

Welcome to OnTraQ! OnTraQ is designed to be ready to use out of the box after 
implementation is complete. Once the configuration defined in your UCCX or UCCE 
servers are imported and displayed as Service Groups and Agent Teams in OnTraQ, you 
can see information about them in OnTraQ as soon as you select them for monitoring.  

This document assumes the CTI Server has been configured for use with OnTraQ and 
that the OnTraQ server has been set up. If not, contact Impact Technologies Customer 
Service for assistance.  

Note: UCCE/PCCE will require a CTI server and the creation of a read-only ODBC 
connection to the UCCE side A and B Historical Data Server.   

This guide contains the following chapters: 

Section 2:  Administrative Tasks discusses initial setup and configuration options you 
will use to prepare OnTraQ for daily use. You will learn how to define sessions, create 
custom agent states, set alarm colors, and more. You may want to define some 
organization-wide Service Groups and Agent Teams, or you may prefer to let each 
OnTraQ user define the groups and teams he or she will be monitoring.  

Section 3:  User Tasks discusses the options users will perform with OnTraQ on a day-to-
day basis. You will learn how to build Service Group Pools, Agent Teams, how to view 
your OnTraQ data and how to modify the way data is displayed within OnTraQ, including 
OnTraQ reports. 

Section 4: Menu Options describes the menu options available from the main OnTraQ 
display.  

This document stresses the process and flow of activities, without trying to explain 
everything you see on-screen. OnTraQ is easy to use and the displays of data are 
intuitive. You choose the data to display and how to display it.  
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2 Administrative Tasks 

After you set up user accounts in Traffic Analyst Administrator, you are ready to begin 
doing administrative setup work in OnTraQ. You will have to start OnTraQ and log in 
before you can perform these administrative tasks. See section 3.1.1 for information on 
starting OnTraQ and logging on. 

Some of the global settings within OnTraQ you may wish to set up before anyone else 
uses OnTraQ include Alarm Colors and Sounds, Session Boundaries, Custom Agent 
States, queue bands, how long some kinds of data will be retained, and the URL that will 
provide OnTraQ access to Traffic Analyst.  

2.1 System Preferences 
Many of the administrative settings are located under the Tools menu option.  The 
System Preferences option allows you to begin with configuring session boundaries, 
queue bands and more.  

2.1.1 Session Boundaries (shifts)  
You can define Session Boundaries in OnTraQ to reflect the shift times your organization 
uses. This will organize the information OnTraQ displays in a way that mirrors the shifts 
your organization members work.  

Go to Tools – System Preferences to define Session Boundaries.  

 
Figure 1 System Preferences  

You can define up to four Session Boundaries to mirror the work shifts within your 
organization. Enter a Begin Time and an End Time to define each Session, which can be 
identical to your work shift begin and end times. You must enter the time in the HH:MM 
format and include an AM or PM. 
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2.1.2 Time-In-Queue Bands – UCCX Only 
Time-In-Queue Bands allows you to organize the way call queue times are sorted and 
grouped by OnTraQ.  

You can define up to four Time-In-Queue Bands for your organization. These are defined 
in seconds. To define these bands, go to Tools – System Preferences. The System 
Preferences window displays. 

 
Figure 2: Time-In-Queue Bands on System Preferences 

Enter the End of Band for each band. In the example above the first Time-In-Queue 
Band is the initial five seconds of the call, the second Time-In-Queue Band will be for 
calls that have been in queue for more than five seconds and fewer than ten seconds, 
and so on. 

Note:  This setting is not available for UCCE deployments.  

2.1.3 Data Storage Time Frames 
The Data Storage Time Frames lets you define for how many days data will be stored for 
the Life of Call and Activity Log reports.   

2.1.4 Direct Call Categories  
Direct call types may be classified as either Primary or Secondary.  As a default, all Direct 
calls are Secondary but each type of call (Out External, Out Internal, In External and In 
Internal) may be individually set as either Primary or Secondary.  This System 
Preferences setting is a global setting that may be overwritten for individual Work 
Groups.  Based on this classification, the Agent Team and Service Group reports will 
reflect the settings along with the state the agent appears in while on a Direct call in the 
real-time Agent Status screen. For instance, if Direct Out External calls are set as 
Primary, then Primary time will include time agents spent on Direct Out External calls 
and the agents will appear in the “Primary Other” column in Agent Status display when 
on external direct calls.  All other direct calls will appear as Secondary. Note: Changing 
the classification will impact all historical report data.   

2.1.5 Object Monitoring Options – UCCE Only 
For UCCE deployments, Object Monitoring Options gives you the option to include 
Precision Queues. If you want analytics for your Precision Queues, check the Precision 
Queues checkbox.  The default is off. If turned on, note the Precision Queues will not 
appear in the system until the next day or after an OnTraQ server restart.  

2.1.6 Reporting Web Service Discovery URL 
This URL is simply the URL that OnTraQ will use to access Traffic Analyst.  
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2.2 Alarms Colors and Sounds 
When alarm conditions are met, an alarm will display and sound. (OnTraQ users can 
define the Alarm Thresholds for the groups and agents they monitor.) To change the 
Alarm Colors and Sounds, select the “Alarm Colors/Sounds” button from the button bar 
on OnTraQ’s main window or select the “Change Alarm Colors/Sounds” option from 
View menu. The Alarm Colors/Sounds window displays.  

  

Figure 3: Alarm Colors and Sounds 

To change a color, select the “Change” button to the right of the alarm state you wish to 
change. The Color window displays (this is a standard Windows option).  

 
Figure 4: Standard Windows Color window 

Use this window to change the color associated with the Alarm Threshold. You can click 
on a color swatch in the grid to select that color, or use the larger color display to select 
a custom color.  

To change a sound, select the “Browse” button and locate the sound file you wish 
played when the alarm condition is met. Sound files must be WAV files that are 
formatted as PCM (8 bit or 16 bit sampling) or ADPCM (4 bit sampling).  

When updated, click OK.  As a final step to save your changes, assure your desktop is 
how you like it and select “Save Window Layout” from Windows menu.  

2.3 Common Organization Definitions 
OnTraQ imports Contact Center Queue, Agent Team and agent information from your 
UCCE/UCCX server.  Contact Center Queues are created on your server by your system 
administrator.  Typically, a Contact Center Queue will be used to route calls to the 
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appropriate agent.   Contact Center Queues are referred to as Service Groups in 
OnTraQ, but otherwise are the same.  

There are also various types of Agent Teams imported and presented in OnTraQ.   

While your OnTraQ users may want to create their own Service Group Pools and Agent 
Teams, there may be some groups and teams you want to create beforehand.  

2.3.1 Service Groups and Pools 
The Contact Center Queues that OnTraQ imports are called Service Groups by OnTraQ. 
Contact Center Queues are set up to route calls, so your system administrator may 
create a Contact Center Queue for sales calls, one for service calls, etc. OnTraQ will 
mirror this structure when it imports. The benefit of Service Groups in OnTraQ then is 
that it gives you a way to monitor and measure call volumes and answer performance. 
You may very well have different service goals for sales calls as opposed to customer 
service calls, for example. Service Groups help you sort the call information.  

In addition, you can also create Service Group Pools which include more than one 
Service Group. This allows you to organize your OnTraQ information in ways that make 
sense for your organization and which will allow you to more quickly view the 
information you want to see.  

For example, you might create a Sales Service Group Pool and include a Sales Service 
Group, a Sales Engineering Service Group, and an After Sale Support Service Group in it.  

You can also create Service Group Pools (and Agent Teams) that are comprised of 
Service Groups (and Agents) from different telephone switches. These “cross-switch” 
Pools and Teams can only be used in historical reports and not in real-time displays. 
Further, historical data for these cross-switch teams will only be available starting the 
next day.  

For more information on creating Service Group Pools, see section 3.2.1.1 Creating 
Virtual Groups.  

2.3.2 Agent and Agent Teams 
OnTraQ imports Agent Team and agent information from your server. Each Contact 
Center Queue on your switch will be displayed as an Agent Team in OnTraQ. There are 
three specific types of Agent Teams in OnTraQ (Queue Team, Supervisor Team, and 
Custom Agent Team). 

• A Queue Team is a collection of agents that are associated with a Contact 
Center Queue in UCCX/UCCE.  They can share a common set of skills and/or be 
part of a defined Resource Group. Agents can be in multiple skill groups in 
UCCX/UCCE and therefore in multiple Queue Teams in OnTraQ.  

• A Supervisor Team is a group of agents defined in UCCX/UCCE as a “Team.”   
Agents can only be members of one (1) Supervisor Team. Not that agents that 
are defined in UCCE/UCCX as supervisors also may be part of more than one 
Supervisor Team.  
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• A Custom Agent Team is a group of agents/teams that are defined in OnTraQ 
and grouped together for viewing/reporting. Custom teams can be personal or 
shared with other users. An agent can belong to more than one Custom Team. 

2.4 Object Monitoring  
The Object Monitoring option, found under the Tools menu, lets you select which 
Service Groups will be monitored by OnTraQ. The default is that none are monitored, so 
you will need to use this option to select Service Groups for monitoring after OnTraQ is 
installed.  

You can quickly choose to monitor all Service Groups by clicking on the Monitor All 
Service Groups button. Likewise, you can choose to not monitor all Service Groups by 
clicking on the Stop Monitoring All Service Groups button.  

The Monitored and Unmonitored checkboxes let you see the list of Service Groups 
displayed in this window.  

To monitor or stop monitoring selected Service Groups, click on the group name in the 
list. If a name is grayed out and highlighted, it means it is not being monitored. Clicking 
on the group name toggles its monitor status.  

Right-clicking on a Service Group name gives you several options – including monitoring 
all or monitoring none of the Service Groups.  

For UCCE deployments with Precision Queues enabled, the Object Monitoring screen 
presents similar options for your Precision Queues.  Select the Precision Queues radio 
button under Explorer and select the Precision Queues you want to monitor.  

2.5 ACD Object Access 
The ACD Object Access option, found under the Tools menu, lets you define the Agent 
Teams, Agents, and Service Groups that an individual OnTraQ user can see and access.  

 

Figure 5: The ACD Object Access window 



ONTR AQ USER GUIDE  

JUN E  2019 IMPACT TECHNOLOGIES,  INC. PAG E  11 

By default, new users will not have access to any agents or groups. You need to give 
them access to selected agents or groups, or give them access to all agents or groups.  

To grant selective access to agents or agent teams, find the agent or agent team in the 
selection tree and click on the name if the name is grayed out. Any grayed out name 
means that the user does not have access.  

To restrict access to an object, click on it and it will turn gray to indicate that the user 
will no longer have access to it. If you click on an Agent Team name, all the Agents in 
that team will turn gray. You can also choose to restrict access to individual Agents by 
clicking on them.  

You can also right-click on an object and get an option to grant or limit access to that 
object to all users.  

The same steps can be used to grant or restrict access to Service Groups as well.  For 
UCCE deployments with Precision Queues enabled, you can add or restrict access for 
Precision Queues in the Service Groups window.  

2.6 ANI/DNIS Groups – UCCX Only 
The ANI/DNIS Groups option, found under the Tools menu, lets you define the ANI/DNIS 
groups that will then be available for use in your Service Group reports.  

ANI stands for Automatic Number Identification, which in OnTraQ refers to the phone 
number of the calling party in a Service Group call. DNIS stands for Dialed Number 
Identification Service, which in OnTraQ refers to the phone number dialed to reach the 
Service Group. 

You don’t need to define ANI/DNIS Groups, but it does give you a way of subdividing the 
calls that come into your organization for tracking purposes.  

 
Figure 6: The ANI/DNIS Groups window 

To create an ANI/DNIS Group, type the name of the group you wish to create in the 
ANI/DNIS Group field and then click Insert New Rule. A dialogue box will pop up asking 
you to confirm the creation of the new group. Select “Yes.” The group is now created. 

A blank row has also appeared in the ANI/DNIS Rules display. Now, you can add ANI and 
DNIS rules that will track specific kinds of calls and callers for this group.  

Under the Type heading, select either ANI or DNIS from the drop-down menu. Under 
Digits to Filter, enter a string of digits (e.g. area code) that will match what the ANI or 
DNIS phone number starts with. 
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Use Length and Length Comparison to enter rules for the length of the phone number. 
For example, if you have entered an area code in the Digits To Filter field, you might set 
the Length field to 10 digits and the Length Comparison field to Longer Or Same Length. 
By doing so, phone numbers that are not within the area code, but begin with these 
digits (e.g. internal, local) would be filtered out. In the example above, for instance, a 
call from extension 3144 would not be accidentally lumped in with calls from the area 
code 314. 

To add additional rules, click on Insert New Rule. 

When you have finished creating the group, click Apply at the bottom of the ANI/DNIS 
Group screen. You may then exit the screen, or click Create New Group to add another 
new ANI/DNIS group. 

Use the Delete column to delete a rule. To delete an entire ANI/DNIS Group, use the 
Delete button to the right of the ANI/DNIS Group field.  

Use the ANI/DNIS Group drop-down menu to select groups for editing.  

2.7 Number Translations 
The Number Translations option, found under the Tools menu, allows you to add digits 
to ANI and DNIS numbers for display purposes.  For instance, you can expand a four-
digit dialing scheme to be displayed as 7 or 10 digits by prepending the NXX or NPANXX, 
respectively.   

2.8 Maintaining OnTraQ servers 
During implementation, OnTraQ was configured to connect to your UCCX or UCCE 
server(s). Should you need to change any of this configuration information, select the 
Tools –OnTraQ Servers option. The OnTraQ Servers window displays.    

 

  
Figure 7: OnTraQ Servers - UCCX 



ONTR AQ USER GUIDE  

JUN E  2019 IMPACT TECHNOLOGIES,  INC. PAG E  13 

 
Figure 8: OnTraQ Servers - UCCE 

To edit existing server information, select the server in the OnTraQ Server dropdown. 
The fields display the server configuration information. To change the information, edit 
any of the fields and then select the Apply option.  

 OnTraQ Server – the IP address (IPV4 only) or Computer Name of the OnTraQ 
server  

 Server Name – any descriptive name you want to give it  

 Switch – the Traffic Analyst switch 

 Host Address - Computer Name 

 UCCX or UCCE radio button – select the type of contact center solution 
deployed 

 Connection Timeout – number of seconds to wait for data from CTI server 
before flipping to the redundant CTI server 

 CTI Server Connections 

o For UCCX deployments, there will be a single Peripheral with ID 1.  
Input the Side A IP Address  and IP Port and potentially the Side B 
information, if applicable.  

o For UCCE deployments, enter the IP Address and IP Port for both Side 
A and B for all Peripheral servers.  Click Add Connection for additional 
servers.  

 ODBC Connectivity (UCCE only) – enter the Side A Name, User ID and Password 
and Side B Name, User ID and Password for the ODBC connection to the UCCE 
database 

To delete the server, select the “Delete” option.  Be careful!  Only delete obsolete 
servers.   
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To create a new server, select the “Create New Server” option and then edit the 
information. 

2.9 Custom Agent States 
OnTraQ gives you the ability to define custom agent states. These states can be 
categorized into Primary, Secondary or Off-line states. Custom Agent States allow you to 
drill deeper into Current and Historical Reports, as well as providing you with the 
greater understanding of what agents are doing when they are, for example, in an Off-
line state for an hour. Only Administrators have the ability to create and edit custom 
states.   

2.9.1 Creating Custom Agent States 
To create a custom agent state, click on the Tools dropdown menu and select Custom 
Agent States. The Custom Agents States window will display. Note that there are a range 
of states in the range of 32xxx that are defaulted in the system based on standard states 
in the Cisco switch.  You may choose to keep these or you can delete any or all of them 
so they will not appear in your reports.  

   
Figure 9: Custom Agent States  

To get accurate reporting in OnTraQ for Custom Agent States configured in Finesse, it is 
important that when you add your custom states that the number assigned to a custom 
state in Finesse be the same number assigned in OnTraQ.  As an example, if “meeting” is 
custom code number 1 in Finesse, then it must be number 1 in OnTraQ otherwise the 
reports will not match.  

To add a new custom agent state, select “Add State” for a new row to appear. Enter a 
Number. Choose Primary, Secondary, or Off-Line from the Report Category dropdown.  
Next select a Display Category.  Options include: Not Ready for Off-Line and Meeting, 
Training and Assignment for Primary or Secondary.  This selection will drive how the 
agent is presented in the real-time Agent Status Display and also in reports for the time 
spent in the new custom state.  Finally, enter a Name for the state. Remember to 
choose a name that describes what agents in this state are doing. Names must be 
unique throughout the system. Numbers 1-4 in Figure above represent sample custom 
states.  You can create up to 65,535 custom codes.  

 



ONTR AQ USER GUIDE  

JUN E  2019 IMPACT TECHNOLOGIES,  INC. PAG E  15 

2.9.2 Editing Custom Agent States 
You may edit Custom Agent States very easily by going to the Tools – Custom Agent 
States option. However, we suggest that you avoid making major changes to custom 
states that already exist, because this can affect data in Historical Reports. 

If you wish to edit a custom state, access the Custom Agent States window and click on 
the field you would like to change. This is particularly useful in the case of fixing typos or 
adding detail to a custom state. For example, let’s say you want to add a Primary – 
Special Project state. You may wish to edit the Name of the initial custom state to be 
Special Project 1, and when you create the second custom state, you could label it 
Special Project 2.  

Unless completely necessary, we recommend not changing the State field for custom 
states. 

2.10 Distributing Reports: The OnTraQ Report Viewer 
When your users create OnTraQ reports, they can distribute the reports to others in 
your organization who do not have the OnTraQ client installed through four different 
methods: 

• The report output can be saved in an Excel spreadsheet format (.xls, .xlsx). 

• The report can be saved in Adobe Acrobat format (.PDF). 

• The report can be saved in XML Paper format (.xps). 

• The report output can be saved in a native OnTraQ report format (.otr). 

If users save the output in an Excel, XML, or PDF format, it’s simply a matter of 
distributing the saved file to anyone who wants to view it in that format.  

If users save the output in OnTraQ’s native format, others in your organizations will 
need the OnTraQ Report Viewer to view the report file. This is a standalone report 
viewer that is free to download from Impact Technologies’ website at 
http://www.impacttech.com/OnTraQSupport. 

Once the Report Viewer is downloaded and installed, it creates a desktop icon. You can 
start the Report Viewer by double-clicking the desktop icon or right-clicking it and 
selecting the Run option. Once started, you can open an OnTraQ report from the File 
menu, though you will need to know the location of the file you want to open.  

An alternative method of starting the Report Viewer is to double-click the OnTraQ 
report file you want to view. If the Report Viewer is installed, double-clicking the report 
file will open the Report Viewer and display the report file.  

http://www.impacttech.com/OnTraQSupport
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3 User Tasks 

This section discusses some of the ways in which you can use OnTraQ on a day-to-day 
basis in your organization. 

OnTraQ is extremely flexible in the way in which you can view the information it tracks. 
There isn’t a right or wrong way to view this information, so think of this section as 
offering some guidelines. To really get the most use from OnTraQ, determine what 
information is most important and build your OnTraQ displays around that goal.  

3.1 Getting Started and Basic Concepts 
OnTraQ organizes your switch data into Service Groups and Agent Teams. You can even 
arrange several groups into a Service Group Pool. In the same manner, you can create 
new Agent Teams and group them together under other teams.  

Also note that these groups and teams can appear in more than one place in OnTraQ. 
For example, you may want to have quick access to a group dedicated to after-sales 
support. You might group them under both a Sales Service Group Pool and a Customer 
Service, Service Group Pool so you can access their data quickly, no matter what Service 
Group Pool you are viewing.    

The following pages detail how to access OnTraQ and build and use your groups and 
teams.  

3.1.1 Logging In 
To log in to OnTraQ, click Start – Programs - OnTraQ. The OnTraQ Supervisor Login 
window displays. 

 
Figure 10: OnTraQ Supervisor Login window 

Enter the IP address of an OnTraQ server and your Username and Password.  

The IP address should be listed in the drop-down list. If it isn’t listed, you can enter it 
directly by typing it.  

After entering the information, click Login to start OnTraQ. The OnTraQ window 
displays. It will initially be blank, but the screen layout you have when you log out of 
OnTraQ will be reproduced when you log in again.  

3.1.2 Logging Out 
To log out of OnTraQ, go to File – Logout. The Confirm Logout window displays: 
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Figure 11: The Confirm Logout window 

If you have made any changes to the default layout, you can save those changes so that 
next time you log in, the OnTraQ display will be as you left it. To save those changes, 
select the “Save Current Window Layout” checkbox.  

Note: Multiple historical reports cannot be saved to the window layout. 

3.1.3 OnTraQ Dashboard  
The window OnTraQ operates in is referred to as a Multiple Document Interface or MDI. 
Essentially, this means that OnTraQ consists of a main window which is subdivided into 
smaller paned windows. Each pane is a separate display. Since panes can be overlaid on 
top of one another, panes that are behind other panes will be accessible through tabs.   

For our purposes, we will refer to this main OnTraQ window as the “Dashboard.” This 
Dashboard can consist of multiple window panes.  

OnTraQ is very flexible in the way it displays its information. Two OnTraQ users may 
choose to view information differently, and the result may be two OnTraQ Dashboards 
that look very dissimilar.  

 
Figure 12: OnTraQ's Dashboard with two panes displayed for UCCX 

3.1.4 Viewing Panes and Wallboard Displays 
OnTraQ information is always displayed in a pane, though you can make a pane into a 
separate window outside of the OnTraQ Dashboard.  
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The following sections describe the different options you have for working with 
OnTraQ’s panes.  

3.1.4.1 Right-Click Options with Panes 
If you right-click with your mouse on many objects in OnTraQ you will see a menu of 
options. Depending on the object you right-click on, the menu will contain different 
options. If you click on the title bar of a pane, you may get the following options: 

• Dockable 

• Hide 

• Floating 

• Auto Hide 

• Move to Next Tab Group/Previous Tab Group 

• New Horizontal Tab 

• New Vertical Tab 

3.1.4.1.1 Docking Panes 

If you choose to Dock a pane, that will lock the pane in an open position somewhere 
inside the OnTraQ Dashboard. If the pane was floating, you can move the pane with the 
mouse and see an indication of where it will dock when you release the mouse button.   

3.1.4.1.2 Hiding Panes 

If you hide a pane, that pane disappears. This option is the same as closing the pane.  

3.1.4.1.3 Floating Panes  

You can float a pane outside the main OnTraQ Dashboard. When you float a pane, you 
can then drag it outside the main OnTraQ display and it will then act as a separate 
window. This is handy for some panes, such as speedometers, histograms, and other 
data displays. You can float one or more of these outside the OnTraQ Dashboard and 
then minimize the Dashboard to free up desktop space on your monitor.  

Floating a pane outside the OnTraQ Dashboard can be especially helpful if you want to 
display it on a Wallboard. OnTraQ supports multiple computer monitors, you can float a 
pane and make it into a separate window, and then drag it into a Wallboard monitor.  

3.1.4.1.4 Auto Hiding Panes 

You can Auto Hide a pane, meaning that the pane will not display when the mouse 
pointer is moved away from the pane. When a pane is Auto Hidden, you can view it 
again by hovering over the pane name displayed in the window frame.  

You can Auto Hide a pane via the right-click options, or you can also click on the 
thumbtack icon in the upper right corner of the pane to Auto Hide it. This thumbtack 
icon is a toggle, so clicking it again will turn off Auto Hide.  
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Figure 13: Service Group Status pane with Auto Hide option 

In the example above, the Service Group Status pane is Auto Hidden. You would hover 
over the title in the lower left corner to display the Service Group Status pane again.  

3.1.4.1.5 Closing Panes 

If you choose to close a pane, the pane disappears. This is the same as hiding the pane.  

3.1.4.1.6 Move to Next Tab Group/Previous Tab Group 

If you have enough panes open so that they are layered and accessible via tabs, you can 
move a pane from one tab group to the next tab group on the immediate right. You can 
also then move the pane back to the original tab group with the Previous Tab Group 
option.  

3.1.4.1.7 New Horizontal and New Vertical Tab 

If there is more than one group open in a paned display, you will have the option to 
display that group in a new horizontal or vertical pane within the pane. In other words, 
these options split the selected pane into two horizontally aligned panes or two 
vertically aligned panes, depending on your selection.   

3.1.4.1.8 Tabbing Between Panes 

If you have multiple panes open, sometimes they are layered and you only see the pane 
on the top layer. The lower layered panes will each have a tab that allows you to access 
the pane. Simply click the tab to bring that pane to the top layer.  

 
Figure: 14: Tabbing Between Panes 

If there are enough panes open, you will be able to access tabs for panes you cannot see 
via arrow buttons that scroll the display of tabs left and right.  
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3.1.4.1.9 Dragging and Dropping Objects 

On many of the OnTraQ panes there are data objects you can move by dragging and 
dropping them. For example, you can change the order of report columns by dragging 
and dropping them to rearrange the report.  

3.2 Explorers 
The upper left corner of the OnTraQ Dashboard is reserved for OnTraQ’s Explorers.  The 
Explorers are designed to work just like the Windows Explorer you are familiar with. 
They list objects in a tree format, and you can select the objects you want to view. 
When you open explorers, an asterisk will appear next to the opened object until you 
close it.   

There are two explorers you can access from the OnTraQ View menu, Service Groups 
Explorer and Agent Team Explorer. Once you have displayed these explorers, you can 
toggle between them using tabs in the explorer pane. As changes are made to your 
contact center configuration (such as adding queues or agents or changing the 
association of agents to queues based on resource assignment or skills changes, those 
changes will be reflected in the Explorer trees. 

To search either explorer tree, type the text in the box in the Explorer toolbar that you 
wish to search for in the tree and hit the arrow ( ).  The first occurrence of the text 
will be highlighted in the tree.  Repeated hits of the arrow will continue to find the next 
occurrence until the last occurrence is highlighted. The search is not case sensitive.  

3.2.1 Service Groups 
Contact Center Queues for Cisco are imported from the switch and displayed as Service 
Groups in OnTraQ. You are not limited to groups you import from the switch, however. 
You can create Service Group Pools, which allow you to group two or more Service 
Groups together.  

You can right-click on a Service Group and see a Properties window for it.  

   
Figure 15: Service Group Properties window 

This Properties window displays information about the Service Group as it is defined. 
You can edit the name that will display in the Explorer tree and reports.  Note the 
Properties also allows you to enter the Access Number for the queue for informational 
purposes only.  
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For UCCE deployments with Precision Queues enabled for OnTraQ monitoring, the 
Service Groups Explorer will include an additional node for “All Precision Queues.”  Each 
monitored Precision Queue will be presented in the tree (based on access rights).  The 
Precision Queue Properties window is similar to the screen shown above.    

3.2.1.1 Creating Virtual Groups 
OnTraQ allows you to organize your Service Groups into Service Group Pools. For 
example, you might have a dozen Service Groups total, with four dedicated to sales, six 
dedicated to customer service, and two dedicated to administrative use. You could 
create a Service Group Pool named Sales and include all the Service Groups dedicated to 
sales, and then do the same with a Customer Service, Service Group Pool and an 
Administrative Service Group Pool.   

You organize your Service Groups with Service Group Explorer, a pane on the OnTraQ 
window. Below is an example. The All Service Groups tree has been expanded, and 
beneath that tree are user-created Service Group Pools.  

  
Figure 16: Service Groups Explorer 

To create a Service Group Pool, right-click in the Service Groups Explorer pane and 
select the “Create Service Group Pool” option. A new Service Group Pool will be created. 
You can also click on the Service Group icon in the upper left corner of the explorer to 
create a new Service Group.  
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Figure 17: Newly created Service Group Pool 

Type the name of the new Service Group Pool to replace the default text that is 
highlighted. After you type the new name, the Add Service Groups and Sub-Pools 
window will display. 

 
Figure 18: Add Service Groups and Sub-Pools Window 

To add Service Groups to your new Service Group Pool, find the groups in the Service 
Groups Explorer tree and drag and drop them onto the new group. You may have to 
expand some Service Group Pools to find the groups you want.  

You can also drag and drop existing Service Group Pools onto the new pool as a quick 
way of adding multiple Service Groups.  

You can also create Service Group Pools that are comprised of Service Groups from 
different telephone switches. These “cross-switch” Pools can only be used in historical 
reports and not in real-time displays.   

3.2.1.2 Properties 
You can edit Service Group Pools. By Right-clicking on the Service Group Pool name you 
will get a menu of options.  

 
Figure 19: Modifying Service Group Pools 
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Many of these options are associated with viewing data for the Service Group Pool. The 
options that let you modify the Service Group Pool include Alarm Thresholds, Remove 
Pool, and Properties.  

The Alarm Thresholds option is discussed later in this document.  

Remove Pool lets you delete the Service Group Pool.  

Properties displays the Service Group Pool Properties window. If you are displaying 
Properties for a newly created Service Group, you will receive some instructions for 
adding new members to the Service Group Pool.   

 
Figure 20: Service Group Pool Properties 

Use this window to change the Service Group Pool name and to either restrict access to 
it or make it viewable by all OnTraQ users. Select “You” to restrict access or “Everyone” 
to make it viewable by all. Note that the Accessible By fields only display for Service 
Group Pools you have created.  
 
 

3.2.1.3 Work Groups 
Work Groups allow you cluster Service Groups to quickly override the system default for 
classifying Direct calls as either Primary or Secondary.  To create new Work Group, right-
click on the All Work Groups node in Service Groups explorer and select the “Create 
Work Group” option. A new Work Group will be created. Right mouse click on the new 
node and select “Properties.”  Use this window to change the name and to set 
accessibility. Select “You” to restrict access or “Everyone” to make it viewable by all. 
Finally, you can override the default Direct Call Categories. Each type of call (Out 
External, Out Internal, In External and In Internal) may be individually set as either 
Primary or Secondary.  This setting allows you to over the System Preferences global 
setting for agents in this Work Group. Based on this classification, the Agent Team and 
Service Group reports will reflect the settings along with the state the agent appears in 
while on a Direct call in the real-time Agent Status screen. For instance, if Direct Out 
External calls are set as Primary for a given Work Group, then Primary time for all agents 
included in the Service Groups that are part of the Work Group will include time spent 
on Direct Out External calls.  Note: Changing the classification will impact all historical 
report data.  As a final step, drag and drop one or more Service Groups (or Precision 
Queues, if applicable) to the new Work Group. Note that if an agent is part of one Work 
Group, you cannot add that Service Group to another Work Group.   

3.2.1.4 Call Types – UCCE Only  

The Call Types node ( ) is available for UCCE deployments only and provides access to 
Historical Call Types report.   
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3.2.2 Agent Teams 
OnTraQ imports various agent team information from your server to get the agent 
information it displays. OnTraQ displays the Queue Teams in the form of individual 
Agent Teams under the All Agents node in the Agent Teams Explorer, where a Queue 
Team corresponds to a Contact Center Queue (or Precision Queue) on the server.  Each 
team lists the agents in the team.  As the association with agents to a queue is changed 
(based on manual assignment changes or updates to agent’s skills in Cisco system), the 
members of the Queue Team in the Explorer list will change.  For instance, if Sam is part 
of Queue Team A in the morning but his skills are updated and he is associated with a 
different CSQ at noon, then Sam will be listed as an agent under his new Queue Team in 
the explorer and will not be listed under Queue Team A.  

Below All Agents in the Explorer is the All Supervisors Teams.  This node contains all  
Supervisor Teams, a group of agents defined in UCCX/UCCE as a “Team.”   You cannot 
make any edits to a Supervisor Team.  

You can organize this Agent information into Custom Agent Teams, much like how you 
organize Contact Center Queues into Service Group Pools. Custom Agent Teams can be 
personal (only visible to the user who created the team) or Shared so everyone can see 
the new team.  The following is an example of the Agent Teams Explorer pane displaying 
Agent Teams and Agents. Note the All Agents, All Supervisor Teams, Shared Teams 
nodes and then any personal teams are listed.  

 
Figure 21: Agent Teams Explorer 

You can see example of user created Custom Agent Team, Marsha Team (expanded). 
You can organize your agents however you want, and agents can belong to multiple 
teams. For example, you might have some newly hired agents handling sales calls. You 
can have these agents in both the Sales Agent Team and create a new team called Sales 
New Agents and place them in this new team to more quickly view their performance.  

Note that when an agent is logged in, the agent entry in the tree will be in blue font and 
include the extension number in parenthesis after the name/ID.  In example above, Rose 
Glen is logged into extension x5003. 
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3.2.2.1 Editing Names of Agents 
When your agent information is imported from the server, it will contain all the agent 
information configured in UCCX or UCCE. You can edit the names of agents so that you 
can more easily understand the agent information that is being displayed in OnTraQ. 
You may find it easier to understand.  

We recommend that your center adopt a naming convention so that all your OnTraQ 
users will apply similar conventions.  

3.2.2.1.1 How to Edit an Agent Name 

To rename an agent, find the agent on the Agent Teams Explorer tree and right-click on 
it.  A list of options displays.  

Select the “Properties” option. The Agent Properties window displays. 

 
Figure 22: Agent Properties window 

You can view the agent status on this window, but you can also rename the agent by 
entering a new Agent Name. Simply type in a new name in the Agent Name field and 
click on OK. The Agent Properties also highlights the extension (if the agent is logged in) 
and the Queue Teams agent is associated with plus the Peripheral ID where defined.  

3.2.2.2 Creating Virtual Teams 
To create a new Agent Team, right-click in the Agent Teams Explorer pane and select the 
“Create New Team” option. A new Agent Team will be created and display in the Agent 
Teams Explorer tree.  

 
Figure 23: Creating a New Agent Team 

Type the name of the new Agent Team to replace the default text that is highlighted. 
After you type the new name, the Add Agents and Sub-Teams window will be displayed. 
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Figure 24: Add Agents and Sub-Teams 

To add Agents to your new Agent Team, find the agents in the Agent Teams Explorer 
tree and drag and drop them onto the new team. You may have to expand some Agent 
Teams to find the agents you want.  

You can also drag and drop existing Agent Teams onto the new team as a quick way of 
adding multiple Agent Teams to the new team.  

You can also create Agent Teams that are comprised of Agents from different telephone 
switches. These “cross-switch” Teams can only be used in historical reports and not in 
real-time displays. 

3.2.2.3 Properties 
You can edit Agent Teams by right-clicking on the Agent Team name to get a menu of 
options.  

  
Figure 25: Modifying Agent Teams 

The options that allow you to modify the selected team are Alarm Thresholds, Remove 
Team and Properties. 

The Alarm Thresholds option is discussed later in this document.  

Remove Team option is available for only limited types of teams (mainly Custom Agent 
Teams) and will delete the team. Note that the team is deleted, but the agents are not.  
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Properties allows you to edit the Team Name and see the type of team.  For Custom 
Agent Teams, you can also use the Agent Team Properties window to either restrict 
access to this team or make it viewable by all OnTraQ users.  

 
Figure 26: Agent Team Properties for a Custom Agent Team 

Note that you can see the OnTraQ server name on this display. For Queue Teams and 
Supervisor Teams you also see the Peripheral ID where the entity is defined.  

Custom Agents are a special Team Type that help you keep track of agents who tend to 
float from group to group. 

3.3 Creating Cross-Switch Pools and Teams  
You can also create Service Group Pools and Agent Teams that are comprised of Service 
Groups and Agents from multiple switches. The data you can see for these cross-switch 
Pools and Teams is only historical data, however, and won’t be available until the next 
day after you create a new cross-switch object.  

To create a cross-switch Pool or Team, you first need to log into both of the switches 
you want to draw from. Your switches are listed under the File menu. The current switch 
you are logged into will be displayed with a checkmark. Simply select the second switch 
and you will be logged into it as well, and then the Agent and Service Group selection 
trees will display objects from both switches.  

Next, create a new Pool or Team. The following window will display: 

 
Figure 27: The Select OnTraQ Server window 

Use the drop-down list and select the “Enterprise (All Servers)” option, and this allows 
you to populate your new Pool or Team with objects from all the switches you are 
currently logged into.  
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The Properties window for the new Pool or Team you create will display the server 
name as Enterprise (All Servers). You can also define this Pool or Team to be accessible 
to everyone or only to you.  

 
Figure 28: The Properties window for an Enterprise (All Servers) Pool or Team 

Note that cross-switch Pools and Teams can only be used to display historical data, and 
that data only becomes available the day following the creation of the Pool or Team.  

3.4 Defining Alarm Thresholds 
You can define Alarm Thresholds for Service Groups, Agent Teams, and individual 
agents. Alarm Thresholds allow you to define the color in which data displays and the 
alarm sound used to indicate an alarm. The colors and sounds each indicate a different 
alarm state.  

If an entity – that is, a Service Group, Agent Team, or agent – doesn’t have Alarm 
Thresholds defined, it may inherit the Alarm Thresholds defined for a parent entity.  

For example, you can have several Service Groups associated with sales activities all 
grouped under a Sales Service Group Pool. You could define Alarm Thresholds for each 
of these Service Groups, or you could leave the definitions blank and define Alarm 
Thresholds for the Sales Service Group Pool. All the Service Groups under the Sales 
Service Group Pool would then inherit its Alarm Threshold definition.  

Once an entity’s Alarm Thresholds are defined, those definitions will be static and will 
not change even if the entity is moved to a different group with different Alarm 
Thresholds. For example, if an agent belongs to Agent Team A and inherited Alarm 
Thresholds from that group, that agent’s definitions will remain in place if the agent is 
moved to Agent Team B. You will have to manually change those definitions.  

(Service Groups cannot have their own definitions and still inherit parent definitions. 
You need to remove definitions if you want them to inherit definitions from a parent 
entity.) 



ONTR AQ USER GUIDE  

JUN E  2019 IMPACT TECHNOLOGIES,  INC. PAG E  29 

3.4.1 Service Group Alarm Thresholds 
Select the Tools – Alarm Thresholds option. The Alarm Thresholds window displays. 
Make sure the Service Group Pool tab is selected.  

 

Figure 29: Alarm Thresholds, Service Groups  

You can define the Service Level and the Service Group Thresholds on the Service 
Group/Pool tab. (The drop-down list shows the current Service Group. You can select a 
different Service Group with this list if you desire. This is just a quick way of changing 
groups you wish to edit.) 

To have the Alarm Thresholds be identical to another group’s settings, select the group 
you wish to copy with the Inherit From drop-down list. The Alarm Thresholds settings 
from that group will be copied to this window and you will see them displayed in pink, 
to indicate that they are inherited settings. To have the settings inherited, click on the 
Set Pool Members to Inherit these Settings button.  

Under Quality Measurements, set the following options: (UCCX only) 

• The Service Level is the maximum time in which you want calls to stay in queue 
before being answered. It drives the % Answered within Service Level Real-time 
Service Group Answer Performance metrics.  

• Check the “Use Caller Experience for Service Level” box to have the “% Calls 
Answered within Service Level” and “Average Time in Queue” columns in the 
Service Level section of the Service Group reports calculated based on the total 
time elapsed since the call entered the ACD system (caller experience), as a call 
potentially passes through multiple queues before being answered. If 
unchecked, the columns are calculated based only on the time the call was in 
the queue that the call is answered from.  Note this setting is applicable per 
Service Group.   
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• Minimum Queue Abandon option sets the minimum duration a customer must 
wait in queue before being counted as an abandoned call.  For instance, if set 
to 3 seconds and caller hangs up after two seconds, the call will not be assigned 
as an “abandon queue” call but as a “hang up.”  

The Service Group Thresholds consist of three time bands; Low, Medium, and High. 
These correspond to the alarm states you want to monitor. You can define Thresholds 
for… 

• # Calls in Queue – the number of calls waiting to be answered 

• Average Queue Time – the average time a call waits in queue before being 
answered (UCCX only) 

• Oldest Call In Queue – the oldest call still waiting to be answered 

• % Ans w/in Service Level – the percentage of calls answered before the service 
level threshold is reached 

• # Agents Logged In – the number of agents logged into the ACD 

• # Agents Ready – the number of agents ready to answer a call but not currently 
working on a call 

• Call In Time – the amount of time spent talking on a call  

• Wrap-Up Time – the amount of time spent in after call work 

3.4.2 Agent Team Alarm Thresholds  
You can define different Alarm Thresholds for different Agent Teams. For example, you 
might want all calls to your Sales Team to be answered more quickly than calls to your 
Customer Service Team. You can define different Alarm Thresholds for each team to 
support this.   

To set Agent Team Alarm Thresholds, select the Tools – Alarm Thresholds option. The 
Alarm Thresholds window displays. Make sure the “Agent/Team” tab is selected. The 
drop-down list shows the current Agent or Agent Team. You can select a different Agent 
or Agent Team with this list if you desire. This is just a quick way of changing Agents or 
Agent Teams you wish to edit. 
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Figure 30: Alarm Thresholds, Agent Teams  

To have the Alarm Thresholds be identical to another group’s settings, select the group 
you wish to copy with the Inherit From drop-down list. The Alarm Thresholds settings 
from that group will be copied to this window and you will see them displayed in pink, 
to indicate that they are inherited settings. To have the settings inherited, click on the 
Set Pool Members to Inherit these Settings button. 

The Agent State Thresholds consist of three time bands, Low, Medium, and High. These 
correspond to the alarm states you want to monitor. You can define Thresholds for… 

• Ready – the time an agent is ready to answer calls but not active on a call 

• Direct – the time in which an agent spends on Non-ACD calls 

• Other – the time spent in the other state 

• Not Ready – the time in which an agent is in an off-line state. 

Note:  If custom agent states are defined, then individual entries for all custom 
states will also be listed in the screen. In example above, Break, Lunch, General, 
Misc and Project are examples of custom states that can now also have alarm 
thresholds defined.  

Another option, Set Team Members to Inherit these Settings, allows you to override 
any individual Alarm Threshold settings you may have defined for agents in this 
selected group.  

3.5 Changing Alarm Colors and Sounds 
The Alarm Colors and Sounds are defined system-wide for OnTraQ. In other words, 
you cannot define different Alarm Colors and Sounds for different OnTraQ users. 
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Normally, these are defined by your OnTraQ administrator. For more information 
on defining alarms, see section 2.2 Alarms Colors and Sounds 

3.6 Status Displays 
OnTraQ can display dynamic information that captures what is happening in your center 
at any given moment through its status displays.  

You can display Agent Team Status and Service Group Status for each Agent Team and 
Service Group you have defined. Further, you can have more than one Status displayed 
at a time. For example, you could have five Agent Teams displayed and three Service 
Groups displayed.  

 

 Figure 31: Status displays in OnTraQ 

In the example above, the Agent Status displays for two different Agent Teams are 
displayed in the top half of the OnTraQ Dashboard, and the Service Group Status is 
displayed in the lower half of the Dashboard.  

3.6.1 Service Group Status 
To view the Service Group Status pane, go to Windows – Service Group Status. This 
displays a pane for Service Groups and Service Group Pools. (The default is to display the 
Service Group Status pane, but if it’s closed for any reason, you can redisplay it.) 

The Service Group Pool will show totals for all the Service Groups that belong to the 
Service Group Pool. You can also see those Service Groups displayed individually in the 
Status Display as well.  

 
Figure 32: Detail from the Service Groups status display for UCCX 
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The data that is displayed represents the Alarm Color states your OnTraQ administrator 
defined. Like other panes in OnTraQ, you can hide, auto hide, float, and dock the Service 
Group Status Display.  

There are three metrics for Service Group Status you can view. These are discussed 
below. 

  

Figure 33: Detail from the Service Groups status display for UCCE/PCCE 

 

3.6.1.1 Metrics 
The Service Group Status Display includes Answer Performance, Queue Status, and 
Agent Status metrics. You can choose to hide any of these by right-clicking on either the 
metric itself or the labeled Service Group area on the left side of the Service Group 
Status Display.  

 
Figure 34: Selecting the information you want to view  

You can also use this right-click menu to redisplay a metric you have hidden.  

When you click on the Service Group column header located on the left side of the 
Service Group Status display, a small arrow appears to the right of the “Service Group” 
text. Use this arrow to reorder the Service Group display. Click on it to reverse the 
order. Click again to revert back to the original order. This option works for all columns 
in the display.  

You can also right-click on the title bar of each metric and choose to hide or redisplay 
individual metrics. For example, in the Agent Status metric you can right-click and 
choose to hide the Ready column. In the Answer Performance metric, you can choose to 
hide all of the Average Queue Time data. To redisplay something you have hidden, right-
click in the appropriate area and you will get a menu of items you can hide and 
redisplay.  
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Figure 35: Hiding columns 

 

3.6.1.1.1 Answer Performance 

The Answer Performance metric defaults to display the percentage of calls answered 
within the defined service level, the average queue time for calls for each data interval 
(not available for UCCE), and the number of calls abandoned as shown below. Additional 
available metric includes average answer time. The data intervals are Quarter Hour, 
Hour, Session and Day, with Session hidden as default.  To display the additional metric 
of average answer time, right-click on the Answer Performance heading and click the 
metric to add to the display. 

 

 
Figure 36: Answer Performance detail – UCCX 

 

 
Figure 37: Answer Performance detail - UCCE 

The service level target for the percentage of calls answered is defined in System 
Preferences. The service level target will also depend on if the User Caller Experience 
box is checked.  

Important UCCE Note: The Service level setting is based on queue configuration settings 
for each queue in UCCE, not the OnTraQ service group threshold settings.  The ODBC 
connection updates every 15 minutes or 30 minutes based on the customer 
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configuration. This will determine the refresh rate for the % Answered w/in Svc Level 
field.  If set to 15 minutes, the Qtr. Hour columns will update each 15 minutes for 
previous quarter hour.  If set to 30 minutes, the Qtr. Hour columns would not be 
available. The Hour columns will update each interval.  If 15 minutes, it will increment 
from last 15 minutes of data, to last 30 minutes, to 45 to 60 minutes for hour and then 
back to last 15 minutes.  If 30 minutes, it will increment from last 30 minutes of data to 
last 60 and back to 30 minutes. 

    
Figure 38:  Answer Performance Additional Metrics 

3.6.1.1.2 Queue Status  

The Queue Status metric displays the current calls in queue and segments them by the 
time bands your OnTraQ administrator defined for your organization. You will also see 
the total number of calls in queue as well as the length of time the oldest call in queue 
has been waiting.  

You can right-click anywhere in the Queue Status display to get an option to hide the 
entire Queue Status display.  

 
Figure 39: Queue Status detail – UCCX  

 

3.6.1.1.3 Agent Status 

The Agent Status metric displays the state the Service Group’s agents are currently in. 
You can see the total number of agents logged in and how many are in the following 
work states:   

• Call In – handling an ACD call for displayed Service Group 

• Call In Elsewhere – handling an ACD call for another Service Group 

• Ready – waiting to receive an ACD call 

• Primary Other– Custom agent states marked Primary 

• Secondary– Custom agent states marked Secondary, Direct Calls, ringing and 
off-hook 

• Not Ready – not available to handle a call 
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Figure 40: Agent Status detail 

 

3.6.1.2 Graphical Displays 
There are two kinds of graphical displays in OnTraQ, Histograms and Speedometers. 
Histograms can be single-state or multi-state. To display a Histogram or Speedometer, 
right-click on the data object you want displayed. You will see a menu that lets you 
choose the kind of display you want.    

 
Figure 41: Right-Click menu for displaying a graph  

 

These graph types are discussed in greater detail below.  

3.6.1.2.1 Histograms 

Histograms can be displayed as column graphs or area graphs. After displaying a 
Histogram, click on the Options button to display the available graphing options. You 
can select the Interval, Range, and Chart Type.  
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Figure 42: A Histogram with data displayed in columns 

The Interval will let you select the data frequency that is graphed on the X axis – in other 
words, what each column or area represents in terms of time. If you select 10 Seconds 
as the interval, for example, then each bar or column represents 10 seconds worth of 
data.  

Range indicates the time range displayed in the graph. For example, if you select 15 
minutes, the entire display will show the most recent 15 minutes of data.  

Chart Type lets you select either a Column or Area display.  

The colors displayed in the graph indicate the alarm state of the object being graphed. 
This is valid only for a normal Histogram. Multi-State Histograms do not show alarm 
colors.  

 
Figure 43: A Histogram with data displayed as an area 

You can also format the Y Axis information in the chart. To do this, right-click anywhere 
inside the graph to access the Format Y Axis window.  
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Figure 44: Format Y Axis window 

This window allows you to set the scale of the Y axis, choose either percent or decimal 
places for the labels, and hide or display vertical gridlines in the histogram.  

3.6.1.2.2 Multi-State Histogram 

You can elect to display a Multi-State Histogram instead of a regular Histogram. Instead 
of showing data for one object, a Multi-State Histogram graphs the states for that 
object. If the object you are graphing is Agent Status, those states will display in the 
Histogram with a color that corresponds to the Agent Status display within the Server 
Group Status pane.  

 
Figure 45: A Multi-State Histogram display 

The options for Multi-State Histograms are the same as the ones described in the 
previous section on regular histograms.    

3.6.1.2.3 Speedometers 

You can choose to display performance information from the Service Group Status Pane 
in the form of a speedometer. This gives you an “at-a-glance” format.  To display 
information, right-click on the data field for which you want to see the information 
graphed in the Speedometer format.  
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Figure 46: Selecting the Speedometer option  

After you right-click and select the “Speedometer” option, the Speedometer Pane will 
be displayed. You may want to use the Float option to reduce the size of the 
speedometer display.  

 
Figure 47: A Speedometer display 

You can use the Options button to access parameters that set the scale for the 
Speedometer. The various colors on the arc below the numbered scale represent the 
Alarm Thresholds.  

You can also create more than one Speedometer. In this way, you can monitor multiple 
data items quickly. You can, for example, create several Speedometers, float them 
outside the OnTraQ Dashboard, and then minimize the Dashboard.  

3.6.2 Agent Status 
When you choose to view Agent Team Displays, you can view a display for Agent Teams 
and Agents. These displays will be arranged via tabs on the Dashboard to make for easy 
switching between the teams and agents you wish to view.  
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Figure 48: Agent Teams and Agent displays  

You can view agent status by agent states, so that each agent is displayed in a column 
representing the state that the agent is currently in. To view this, right-click on an Agent 
Team in the Agent Team Explorer and select “Display Agent Status” to see the status of 
all agents in the Agent Team.  

Each column also displays the time that the agent has been in the current state. You can 
order the display of agents in each state by longest or shortest amount of time in that 
state by clicking on the arrow to the right of the Time label.  

Note: An Agent may appear in a different color font if their status is currently in an 
alarm state (e.g. in an Ready state for more than 60 minutes). An Agent that is 
highlighted gray indicates the agent is currently using their second phone line.   

 
Figure 49: Detail from the Agent Status display 

Agent state columns, as well as the columns within each state, can be hidden and 
unhidden, depending on what you are interested in viewing. Simply right-click the 
header of an agent state column and options will be displayed. For example, if you right-
click the Secondary header, you have the ability to hide the entire Secondary column, or 
you may hide or unhide the Agent, Task, Phone Number and/or Time columns. Columns 
that are not currently hidden will have checkmarks next to them, while columns that are 
hidden will not.  

 
Figure 50: Hide and Unhide Columns and States in Agent Status display  

Notice that agent states that are currently hidden are shown at the bottom of the right-
click menu in the Hidden States section. To unhide one of these hidden states, simply 
select it from this menu. 
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Note: If a window layout with the Agent Team Display has been saved, any columns that 
are hidden will remain hidden upon logging out and logging back in to OnTraQ. 
Alternately, if a logged-in user closes the Agent Team Display and then reopens it, it will 
always be opened in the default view, which includes all agent state columns. However, 
any time a user logs in to OnTraQ, the Agent Team Display will still be formatted as it 
was for the saved window layout (with hidden columns, etc.). 

3.7 Modify Agent State 
OnTraQ allows users to view and modify individual agent’s states, in addition to being 
able to view multiple agents’ statuses simultaneously. To view individual agent states, 
right-click on an agent in the Agent Team Explorer and select “Modify Agent State.” 
When you display an agent state individually, you see the agent’s current state, and you 
can also change their state from this window. You can also access this screen with a 
right mouse click on an agent in the Agent Status display and selecting “Modify Agent 
State.”  

 
Figure 51: Modify Agent State display 

To modify state, select the desired new state from the “State” dropdown in the “Change 
To” section of this window. Default states for agents currently logged on to their phones 
include Logoff, Ready, Not Ready or any custom code created. (Note that the 
Administrator may define additional custom states. (See 2.9.1 for more detail on 
creating custom agent states.) 

After you have selected the State to change an agent to, press Apply for the change to 
take effect. If the agent is in a non-call state, you will instantly see the change reflected 
in the Current fields in the top half of the Agent State window. If the agent is in a call 
state, the changes will take effect as soon as the call has ended. 

3.8 Activity Log 
3.8.1 Agent Activity Log 

The Agent Activity Log displays information about the selected agent’s work status. You 
can choose to display either current or historical data for four different categories of 
activities: Agent States, 2nd Line Events, System Events, and Alarms.  

• Agent States – the history of the states the agent was in for the selected time 
period. 

• 2nd Line Events – any event that utilized an agent’s second line during the 
selected time period. (UCCX only) 
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• Alarms – any alarm thresholds that were breached during the selected time 
period.  

• System Events – any system events that were recorded during the selected 
time period.  

 
Figure 52: Agent Activity categories 

To see the Activity Log for a specific agent, right-click on an agent in Agent Explorer and 
select the “Activity Log” option or right mouse click on agent in the Agent Status display 
and select “Display Agent Activity Log.”  

Please note that the Activity Log uses the time zone information pertaining to the switch 
that hosts the Agent Group to determine the time ranges for the last quarter hour, hour, 
and current session.  

3.8.1.1 Using the Agent Activity Log 
To display information in the Agent Activity Log, select the Detail, Category, and Activity 
for which you want to display information. These are all drop-down menus that filter 
the information that will be displayed in the report. Note: You can print any of these 
displays or export them to Excel using the Print and Export buttons in the upper left 
corner of the Activity Log pane, respectively. 

For the Detail drop-down menu, your choices are Qtr. Hour, Hour, Session, Full Day, and 
Pick Date (to see historical data). The data interval you select will then display with a 
rolling total that is updated in real-time, unless you selected “Pick Date...” 

(To see historical data, select the “Pick Date…” option to display a calendar and then 
select the past date for which you want to view Historical data.)  

For the Category drop-down menu, you select the type of information you want to 
display -- Agent States, Alarms, System Events, 2nd Line Events or All Categories. All 
Categories will include information from each of the categories in the report.  

For the Activity drop-down menu, you can select one activity or All Activities. Available 
activities are based on the Category selection. For example, if you selected “Alarm 
Thresholds” in the Category drop-down, your Activity drop-down selections will be 
based on alarm thresholds. If you select “All Categories” in the Category drop-down, 
then the Activity drop-down will display all the activities associated with the three 
categories.  

Once you have data displayed, the following data items are included in the report:   

• Activity – the activities the agents performed as recorded by the ACD.  

• Service Group – the service group that the call was routed through before 
being answered by the agent.   

• Alarm – any alarm conditions that occurred.  
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• Up Arrow/Down Arrow column (to the right of the Alarm column) – this column 
will show whether the alarm condition is trending upwards or downwards. 

• Time Elapsed – the total time in each state.  

• Start Time – the time the agent entered a state.  

• End Time – the time the agent left the state.  

 
Figure 53: Agent Activity Log 

Note that there’s also a column of icons to the far left of the display. These icons 
correspond to the activity state.  

You can hide or display any of the columns by right-clicking on a column heading to see 
a list of available columns. Uncheck or check a column name to hide it or display it.  

With a right mouse click within the Activity Log, you can access options to display the 
Life of Call report for agent, print or export the report data.  

3.8.1.2 Agent Activity Log: Agent States 
Agent States will report on the following data items: 

• Ready – displays when an agent is available to take a call but not currently on a 
call.  

• Logged In – displays the start and end times for the agent being logged in, and 
the total duration of the login time. 

• Logged Out - displays the time the agent logged out.  

• Direct Call In – displays when an agent is handling an incoming Direct call.  

• Direct Call Out – displays when an agent is making an outgoing Direct call. 

• Other – displays the off-hook and ringing time for an agent. 

• Call In – displays the seconds spent on the queued call by this agent. 

• Not Ready – displays the time spent in the unavailable state by the agent. 
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• Wrap-Up – displays the time spent in the wrap-up state immediately after a 
queued call by the agent. 

• If custom agent states are defined, those will also appear, such as “Assignment-
Project State” in above example.  

3.8.1.3 Agent Activity Log: 2nd Line Events  (UCCX only) 
2nd Line Events will report on the following data items: 

• 2nd Line Call In – displays when an agent is handling an incoming call to their 
second line. 

• 2nd Line Call Out – displays when an agent makes an outgoing call from their 
second line. 

• 2nd Line Call In – displays the time spent by an agent on a second line call. 

Note: 2nd line events are only available on UCCX.   

3.8.1.4 Agent Activity Log: Alarms 
Alarms will report on the following data items: 

• Ready Time – the alarm threshold state of an agent’s time waiting for a call. 

• Direct Call Time – the alarm threshold state of an agent’s time spent on Direct 
Calls. 

• Other Time – the alarm threshold state of an agent’s time spent in the Other 
state. 

• Call In Time – the alarm threshold state of an agent’s time spent in the Talk Time 
state. 

• Not Ready Time – the alarm threshold state of an agent’s time spent in the Not 
Ready state. 

• Wrap-Up Time – the alarm threshold state of an agent’s time spent in the Wrap-
Up state. 

• If custom agent states are defined and alarms configured, alarms for those 
states will also appear. 

3.8.1.5 Agent Activity Log: System Events 
System Events reports on switch- and server-related OnTraQ activity and will report on 
the following data items: 

• Connected to Server – the time OnTraQ has spent connected to the UCCE/UCCX 
server.  

• Data Stream Started – the time at which OnTraQ began receiving data from the 
UCCE/UCCX server. 

• Data Stream Stopped – the time at which OnTraQ stopped receiving data from 
the server. 

• Lost Connection – the time at which OnTraQ may have lost its connection to the 
UCCX or UCCE servers. 

• OnTraQ Server Started – the time at which the OnTraQ server was started.  
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• OnTraQ Server Started – the time at which the OnTraQ server was started.  

3.8.2 Service Group Activity Log 
The Service Group Activity Log displays information about the selected service group. 
You can choose to display either current or historical data for System Events and Alarm 
Thresholds. To view the Service Group Activity Log, right-click on the Service Group 
name in Service Group Explorer and select the “Activity Log” option or right mouse click 
on a service group in the Service Group Status display and select “Activity Log.”  Also 
available for Precision Queues, if you have enabled them.  

 
Figure 54: Service Group Activity Log  

3.8.3 Historical Activity 
In addition to displaying the Activity Log in the Dashboard and exporting the data, the 
Historical Activity report allows you to save your report criteria and be able to schedule 
the report.  From either the Agent Teams or Service Group Explorer, right mouse click 
on the object you want to see and select “Historical Activity” option. You may select a 
Personal or Shared report template or create a new report.  

 
Figure 55:  Historical Activity report with Options  

When the report displays, use the Options at the bottom of the screen to build your 
report criteria.  You can select the dates, time periods, activities and categories to 
include in the report.  Name the report in the “Save As” box and save your report to be 
available for only you or everyone.  You can also simply display the report in your 
Dashboard by hitting “Display” button.  Refer to section 3.10.2.1 for more information 
on Report Options.  
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3.9 Life of Call 
You can access a Life of Call report for individual agents, Agent Teams, or Service 
Groups. To see a Life of Call report, right-click on the Agent or Service Group name and 
select the “Life of Call” option. You can also access a Life of Call report by right-clicking 
on an object in the Activity Log or in any current or historical report and selecting the 
“Life of Call” option. This will display a Life of Call report for the selected object. Also 
applicable for Precision Queues, if you have enabled them. 

 
Figure 56 Access Life of Call from report  

The Life of Call report displays a chronology of the call activity. It presents a “snapshot” 
of the call as captured whenever the user chooses to display the Life of Call report. You 
select the Date, Start Time, and End Time for which you want to view Life of Call 
information, and then click on the Go button to display the information.   

The Life of Call report is segmented into call states for the call being tracked. Each call 
has a summary row in the report and this is all that initially displays, but this summary 
row can be expanded via the control button to the left of the summary row to show the 
various call states that the call experienced.  

Please note that the call state displayed in the summary row is the final call state that 
the call experienced. If you expand the summary row to show all the call states for the 
call, remember that the summary row does not display the initial call state but displays 
the final call state.  

 

Figure 57: Life of Call 
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The data fields associated with the call you see in this report are:  

• Start – when the call state began 

• End – when the call state ended 

• Elapsed – the total time of the call state 

• Service Group – the Service Group that the call was routed to before it was 
answered by an agent 

• Agent – the agent who handled the call 

• Activity – the different call states the call progressed through, such as In 
Queue, Ringing, Call In, etc. 

• Connected Party – the party associated with the Activity 

• Calling Number – the number originating the call 

• Called Number – the number dialed by the originating number 

Note: “Unknown” appears in the Calling Number and/or Connected Party fields when 
the number is unavailable. 

You can filter the display to show only calls that had a selected Activity occur, such as all 
calls that were completed normally, all calls that were sent to an agent, etc. To filter the 
calls, select the Activity you want to use as the filter from the Activity drop-down list.  

You can also drag and drop the columns to rearrange them.  

To hide or redisplay any of the columns, right-click on a column heading to see a list of 
columns, uncheck or check a column name to hide it or redisplay it. 

To print a Life of Call display or export it to Excel, use the Print and Export buttons in the 
upper left corner of the Life of Call window, respectively. 

3.9.1 Historical Life of Call 
In addition to displaying the Life of Call in the Dashboard, the Historical Life of Call 
report allows you to save your report criteria and be able to schedule the report.  From 
either the Agent Teams or Service Group Explorer, right mouse click on the object you 
want to see and select “Historical Life of Call” option. You may select a Personal or 
Shared report template or create a new report.  



ONTR AQ USER GUIDE  

JUN E  2019 IMPACT TECHNOLOGIES,  INC. PAG E  48 

 
Figure 58:  Historical Life of Call report with Options 

When the report displays, use the Options at the bottom of the screen to build your 
report criteria.  You can select the dates, time periods and activities to include in the 
report.  Name the report in the “Save As” box and save your report to be available for 
only you or everyone.  You can also simply display the report in your Dashboard by 
hitting “Display” button.  Refer to section 3.10.2.1 for more information on Report 
Options.  

3.10 Performance Reports 
OnTraQ lets you create Performance Reports for your Service Groups, Precision Queues 
(if applicable and enabled), Service Group Pools, Agent Teams and Agents. There’s a 
wide variety of data types you can include in these reports. For example, you can create 
a Performance Report that shows, for the Agents selected, the number of calls received, 
the number of calls unanswered, the number of calls abandoned, and the number of 
calls picked up. Those are just four of the data items you might build a report around. 
There are many more you can include, such as Total Call In Time per call, Total Ready 
Time, and so on.  

OnTraQ provides the framework for building performance reports. You add to the 
framework by selecting the data types you want to see in the report. You might design 
one report that tracks just a few data items and another that tracks a dozen or more.  

You can also share your saved report templates with other OnTraQ users or keep them 
private for your own use. When you share a report template, that allows other users to 
generate reports based on that template, and it also lets them take your template and 
modify it and save it under a new report name. You may have some data items in your 
report that another user isn’t interested in seeing, so he or she can remove them and 
save the report template under a new name. Likewise, another user may wish to add 
other data items that you didn’t include.  

You can also share reports with others in your organization, even if they are not OnTraQ 
users. You can save the report output to an Excel spreadsheet format, or you can save 
output to OnTraQ’s own report writer format.  

You can download a version of this report viewer from Impact Technologies’ website 
http://www.impacttech.com/OnTraQSupport and any OnTraQ historical report data 
saved in the native OnTraQ format can then be viewed with this free report viewer. This 

http://www.impacttech.com/OnTraQSupport
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report viewer is used to view historical report data exported to a file or e-mailed as an 
attachment. 

Refer to the OnTraQ Data Dictionary for more information about the report data items. 

3.10.1 Current and Historical 
You can create Performance Reports that display historical data and you can create 
reports that display current data in a dynamic fashion, including rolling totals for hours, 
quarter hours, sessions, and days. Current Reports will update their displays in real-time 
to reflect changing data.   

Further, you can create current and historical reports for Service Groups, Service Group 
Pools, Precision Queues, Agent Teams, and Agents.  

To create a report, just right-click on the object (the group, team, or agent) in the 
Explorer Tree you want to include in the report. See the following example: 

 
Figure 59: The Current Performance Report option for an Agent Team 

In this example, the user is selecting a “Current Performance” report for the “Marsha 
Team.” The user has selected a “Shared Report,” meaning a report format that an 
OnTraQ user has previously defined and shared with all users. The name of the report 
the user is selecting is “Summary.”  

You can also access a Life of Call report from any current or historical report.  Right click 
on the object to access an option to display the Life of Call Report. 

3.10.2 Service Groups and Agent Teams  
You can choose to create and display reports for your Service Groups, Service Group 
Pools, Precision Queues, Agents, and Agent Teams.  
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Right-Click on the object you want to generate a report for, either a Service Group, 
Service Group Pool or Precision Queue in the Service Groups Explorer, or the Agent 
name or Agent Team name in the Agent Teams Explorer.  

After right-clicking, select either “Current Performance” or “Historical Performance” to 
see either a current dynamic display that updates in real-time, or a historical display of 
past data. Under either Current or Historical you will see the default reports and any 
user-defined reports that are available for all users to view.  

You can also choose to design a new report for either Current or Historical by selecting 
the “New Current Report” or “New Historical Report” options.  

Note that for reports requested for Queue Teams and individual agents under a Queue 
Team within the All Agents node in Agent Team Explorer, the report Service Groups 
filter will always be defaulted to the Service Group associated with the Queue Team 
(and not “Total”). This allows the report to reflect only the agents’ activity associated 
with the specific queue.  If you want to see all the activity for the agents across all or 
multiple queues, create a Custom Agent Team and drag a copy of this team to it. Note if 
you schedule a report for a Queue Team or agent within the Queue Team, the output 
report will also be restricted to activity related to single queue. A scheduled report for 
the Custom Agent Team will allow all or multiple queues.  

3.10.2.1 Report Options 
Report Options are the building blocks of Service Group and Agent Team Performance 
Reports.  

 
Figure 60: Detail from Report Criteria 

The following criteria are available when you create new Service Group or Agent Team 
Performance Reports:  

• Date Selection (for Historical Reports only) 

• Time Periods (for Historical Reports only) 

• Report Detail 

• Service Groups (Agent only) 

• ANI/DNIS (Service Group only) 

• Data Groups 

• Formatting 

• Save As and Available To 

These are explained in detail in the following sections.  



ONTR AQ USER GUIDE  

JUN E  2019 IMPACT TECHNOLOGIES,  INC. PAG E  51 

3.10.2.1.1 Date Selection 

Date Selection allows you to choose the date range for displaying a Historical 
Performance Report.  

 
Figure 61: Date Selection for reports 

You can select: 

• All Available – all available historical data for the selected Agent Team or 
Service Group. 

• Current – the current day, week, month or year. 

• Last X number of Y – where X is number of units and Y is the type of unit, days, 
weeks, or months. Weeks are Sunday through Saturday and days are midnight 
to midnight. Note that you cannot change these Sunday through Saturday and 
midnight to midnight range designations.   

• Start and End – a beginning and ending date range. Selecting this option will 
display a calendar that allows you to select the date range.   

3.10.2.1.2 Time Periods 

Time Periods lets you select the time range for the Performance Report.  

 
Figure 62: Time Periods for reports 

You can select: 

• Days – All days, Primary days, or Non-Primary days 

• Hours - All hours, Primary hours, or Non-Primary hours 

• Start and End – a beginning and ending time range in the HH:MM:SS AM/PM 
format 

Note that Primary days and hours are defined in Traffic Analyst.  

3.10.2.1.3 Report Detail  

Report Detail lets you select the granularity of data displayed in the Performance 
Report.  
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Figure 63: Report Detail 

You can display any or all of the following:  

• Quarter Hour  

• Hour  

• Day  

• Week or Month Totals (not both) 

You can also display information by Organization Level, choosing to display all levels 
(Max) or levels 1 through 6. The way levels work is by designating the object you initially 
select to generate the report as the parent object, and all objects underneath it as 
children objects.    

For example, if you select a Sales Agent Team as the initial object for your report then 
this becomes the parent object, or the level 1 object. Every object directly underneath 
becomes a level 2 object. Any objects beneath those become level 3 objects, and so on. 
When you select Organizational Level 1, you would only see a report with cumulative 
information for the Sales Agent Team. If you selected Organizational Level 2, you’d see 
both the cumulative Sales Agent Team data and also cumulative data for each child 
object directly beneath the Sales Agent Team.   

3.10.2.1.4 Service Groups  

The Service Groups section displays only when you are creating an Agent or Agent Team 
Performance report. This section allows you to select the Service Groups for which you 
want report information displayed.  

 
Figure 64: Service Groups selection for reports 

Click on the checkbox next to the name of the group if you want to see it represented in 
the report.  
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Note: Service Groups filter defaults to “Total” for reports unless the requested report is 
for a Queue Team or agent under a Queue Team. Then the filter is set to associated 
Service Group for Queue Team.  

3.10.2.1.5 ANI/DNIS  

The ANI/DNIS section displays only when you are creating a Service Group Performance 
report. Also only available for UCCX systems.  

This section allows you to select the ANI/DNIS for which you want report information 
displayed.  

 
Figure 65: ANI/DNIS selection 

Click on the checkbox next to the name of the ANI/DNIS if you want to see it 
represented in the report. 

3.10.2.1.6 Call Types 

Available only for UCCE deployments, the Call Types Historical Performance report 
includes a section to select the individual call types to display for the report.  Click to 
check the individual Call Types you want to include in the list.  Note that all selected call 
types are displayed alphabetically at the top of the list and unchecked call types are 
listed below.  As another convenience you can click the “Select Call Types” button to 
open a larger window to display more call types if your organization has many 
configured call types. Click the “Clear Call Types” or “All Call Types” check boxes to 
quickly exclude all or include all entries.  Or, you can filter the view by entering your 
criteria in the Filter box.  You can have multiple filters and separate them with a comma. 
Click Apply for the filter.  Select the call types to include and press “OK” to save.   

 
Figure 66: Call Types selection 

3.10.2.1.7 Data Groups 

The Data Groups section lets you select the data types you want displayed in the report.  
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Figure 67: Data Group selection 

Click on the checkbox next to the name of the Data Group if you want to see it 
represented in the report. Each Data Group is comprised of several individual sets of 
columns. If you deselect a Data Group, all of the columns associated with that Group will 
no longer be displayed in the report.  

You can also deselect individual columns within a group to remove them from the 
report by right-clicking on the report column within the Data Group to get a list of 
columns to select and deselect. See 3.10.3.1 Report Columns for more information.  

Note that the Data Groups available for use in a report vary by report format. For more 
information on the Data Groups refer to the OnTraQ Data Dictionary.  

3.10.2.1.8 Formatting 

Formatting allows you to set how durations/times display in reports.  

 
Figure 68: Formatting  

You have the following choices you can select from the drop-down list: 

• Hours/Mins/Secs (hh:mm:ss) – this shows the time for the report item in hours, 
minutes, and seconds. 

• Hours No Decimals – this shows the time in hours, with the time rounding up to 
the next hour. For example, if talk time were one hour and 46 minutes, Hours 
No Decimals would display that as two hours.  

• Hours One Decimal – this shows the time in hours extended out to one 
decimal, with the time rounding up to the next decimal. For example, if talk 
time were one hour and 46 minutes, Hours One Decimal would display that as 
1.8 hours.   

• Hours Two Decimals – this shows the time in hours extended out to two 
decimals, with the time rounding up to the last decimal. For example, if talk 
time were one hour and 46 minutes, Hours Two Decimals would display that as 
1.76 hours. 

3.10.2.1.9 Save As and Available To 

The Save As and Available To options allow you to save a report format you have 
created and determine who else can use that format.  
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You can reserve the use of the report format to yourself by selecting the “You” radio 
button, which means it is only usable by you, or you can make it available for use to 
anyone else by selecting the “Everyone” radio button.  

The advantage of limiting the use to yourself is that it will not clutter up the list of 
available report formats that others will see if the format you create isn’t of interest to 
other OnTraQ users.  

3.10.3 Displaying the Report 
Once you have selected the Report Criteria you desire, click on the Display button to 
generate the report and display it in the Report window. The upper portion of the 
window will display the report.  

  

 
Figure 69: Detail from the Reports window 

Any report row with a tree control button (the plus or minus sign) next to it can be 
expanded or collapsed. You can also hide the Report Criteria by clicking on the Options 
button (also a plus or minus sign) next to the Criteria label. That will free up space in the 
window to display more of the report.   

You can also modify your report by using the Report Options. Change the settings you 
find under Options to get the custom report you need.   

3.10.3.1 Report Columns 
You can manipulate the columns in a report. You can drag and drop columns to 
rearrange the report display, and you can also choose to hide or display columns. To 
hide or display a column, right-click on the section header to see a list of the columns; 
uncheck a column to hide it, and check a column to redisplay it. Click “OK” to save your 
changes. 
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Figure 70: The column checklist for the Total Calls section of this report 

3.10.4 Graphing Options – Ad Hoc and Template 
You can also choose to graph the information from a historical report. Right-click on a 
data point in the report and then select the “Chart Data” option. This brings up a graph 
with two tabs in the Options section, Ad Hoc and Template. 

The Ad Hoc tab lets you design a report to be displayed in the graph for one-time use. 
The Template tab lets you design a report chart that will be saved and made available 
for use every time the report template to which it belongs is used.   

Within the Ad Hoc tab, there are two more tabs you can view. The Fields Chart tab will 
display information for one agent, with the ability to display multiple Data Fields for that 
agent’s performance (shown below).  

The Agent’s Chart (not shown below) will display information for multiple agents for one 
selected Data Field.  
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Figure 71: Agent Performance Fields Chart 

The tabbed Charts let you select the following: 

• Agent/Team (Ad Hoc only) – the selected Agent or Agent Team that will be 
graphed 

• Fields – the data items that will be graphed 

• Frequency – the granularity of the graph 

• Chart Style – the type of chart including Line, Area, Column or other 

• Show Legend – check to show the legend to the right of the graph or uncheck it 
to enlarge the graph 

• Y Axis and X Axis – change the font size of the labels, the time units and the 
label on the Y axis 

• Start and End – the beginning and ending time range that will be graphed 

• Name (Template only) – enter a name for the chart you designed 

• Front Chart Displayed (Template only) – select which chart will be displayed by 
default when the charting option is selected for this report template, or choose 
to display a different chart the chart currently displayed. 

After you make any changes, you need to click on the Apply Chart Setting button to 
redisplay the graph with the changes reflected.  

3.10.4.1 Formatting the X Axis and the Y Axis 
You can edit the values for the X and Y axes to change the font size of the labels, the 
time units, and the label on the Y axis. Click on the X Axis or Y Axis buttons or right-click 
anywhere in the graph to access these editing options.  
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Figure 72: The Y Axis Format options 

When you format the Y axis, you can change the title (label) of the Y axis and font size of 
the lettering of the title, the scale of the Y axis, and font size, type, and format of the 
scale enumerators on the Y axis. Type will be number, percent, quarter-hour, half-hour, 
or hour. The format will be the number of decimals used.  

The X axis format options let you change the font size of the enumerators and also 
select the kind of time and date units that will be displayed, either 12 hour time or 24 
hour military time, and the date in either month-year format or month-day-year format.  

Remember, you can try different values and settings and use the Apply Chart Settings 
button to redisplay the graph with your new settings. Try different combinations until 
you find settings that give you the kind of graph you need.  

3.10.5 Saving, Deleting, Exporting and Scheduling 
When you define a report by selecting the Report Criteria, you can save your format for 
reuse, export the report data in one of four formats, print the report or schedule the 
report to be generated at a later time and date.  

3.10.5.1 Saving a Report Design 
To save a report design, enter a name for the report in the Save As field.  

Next, select whom you want to make this report format available to, You or Everyone.  

Finally, click Save to save this report format.  
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Figure 73: Saving report formats 

3.10.5.2 Deleting Report Templates 
To delete a report template, go to Tools – Report Templates.  Find the report you want 
to delete in under the Agents & Teams or Service Groups explorer tree. Right mouse 
click on the report and select “Delete Report Template.”  Note, based on your security 
you may be limited to the report templates that you can delete.  

3.10.5.3 Exporting Reports 
You can also export the report data in four formats – an Excel spreadsheet format (.xls, 
.xlsx), OnTraQ’s own report format (.otr), Adobe Acrobat format (.PDF), and XPS, which 
is Microsoft’s alternative to PDF. 

To export a report, right-click anywhere in the data portion of the report. Then, click the 
Export option. When you select the “Export” option, you are presented with the 
standard Windows file save dialog that lets you select the file name and location that 
the exported file will be saved to.  

The OnTraQ Report Viewer is a standalone application that anyone in your organization 
is welcome to install and use. The report viewer is available at Impact Technologies’ 
website (http://www.impacttech.com/OnTraQSupport) or through installation from the 
OnTraQ CD.  Refer to section 2.10 for more information on OnTraQ Report Viewer.  

3.10.5.4 Scheduling Reports 
To schedule a report, you need to create a new scheduled activity. This new activity will 
not contain any report information. Follow these steps to create a report schedule.  

1. Go to Tools and select the “Scheduled Activities” option. This will display the 
Scheduled Activities pane. Right-click anywhere inside the Scheduled Activities 
pane and select the “Create Scheduled Activity” option. A new object appears 
with the default name of “A New Scheduled Activity.”  

2. Rename the new scheduled activity object. Once you rename, the following 
window displays with instructions for creating your scheduled activity. Click on 
OK.  

 
Figure 74:  Creating a new schedule activity 
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3. Find the historical report template you want to schedule and then drag it and 
drop it on the new scheduled activity you created. (If you do not have the 
Report Templates pane open, go to Tools and select the “Report Templates” 
option.) You will see the report template displayed underneath the scheduled 
activity.  

4. Find the Service Group or Agent Team you want to be included in the report in 
the Service Group Explorer or Agent Team Explorer, and drag and drop it on the 
report template beneath the scheduled activity. The object you dropped will 
display beneath the report template. Note that only Agents or Agent Teams can 
be dropped onto an Agent report, and that only Service Groups, Service Group 
Pools or Precision Queues can be dropped onto a Service Group report. 
Remember that you can also drag and drop more than one object onto a 
report. An example of three scheduled reports is displayed below:  

 
Figure 75: Detail from the Scheduled Activities pane 

5. Right-click on the new scheduled activity and select “Properties.” The Schedule 
Activity window displays. Note that a newly created scheduled activity will by 
default always be Active. Check the “Inactive” box if you wish the scheduled 
activity to become inactive. 

 
Figure 76: The Schedule Activity window 
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6. Schedule the report. You select the time of day and day of week, or day of 
month. Note that you can select more than one day of the week or day of 
month.  

7. Select the report output. Your options are: 

 Send output to a network printer (you can select the printer as well) 

 Save output to a network file (use the default or enter the filename 
and file location) 

 Save output as an attachment via e-mail (you enter the filename and 
the e-mail addresses the file will be sent to) 

 Send a link to the file via e-mail (you enter the filename and the file 
location, and the e-mail addresses the link will be sent to) 
 
Note that even if you are attaching the output to an e-mail, you still 
have to select a location for the report file to be saved to. Both 
OnTraQ and Traffic Analyst save the source file when generating a 
report.  

8. Save the schedule by clicking on Save Schedule.  

Once the report is scheduled, it becomes a recurring event. If you do not want the 
report schedule to repeat, either delete the scheduled activity once you are finished 
with it or click on the Inactive checkbox to make it inactive. An inactive report retains its 
scheduling information and can be turned back on by clearing the inactive checkbox. 

Important Note:  Any historical reports with day totals must be scheduled for 30 minutes 
after the end of day time setting in Traffic Analyst or else the day totals won’t be 
accurate. Normally, this setting in Traffic Analyst is the default server setting for the end 
of day. Traffic Analyst users can change the end of day time in Traffic Analyst, however. 

3.11 Custom States in Reports 
If you choose to leverage custom agent states, your Current and Historical reports can 
provide you with the actionable detail that you are looking for. As you create new 
custom states, these states automatically appear in the Time in State report data group.  

In addition to the default custom state types of Not Ready, you can also define Primary 
or Secondary states. Within those states, there are display categories of Training, 
Meeting, and Assignment.  If you define custom states using these categories, the 
reports will display these report columns, shown below as Training, Meeting, and 
Assignment, with totals for the time in state for each. 

Note that all custom states will figure into the total service group or agent Time in State 
for the selected state-type. In the following example, the columns on the right show the 
agent was on Break for 0.24 hours, in a Meeting-General for 0.04 hours, and at Lunch 
for 0.2 hours.  
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Figure 77: Custom States Report  

For more information regarding Custom Agent States, please see the relating section, 
2.9, which discusses how to create and utilize custom states. 
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4 Menu options 

There are six menus in OnTraQ: File, Edit, View, Tools, Window, and Help. These are 
discussed below. 

4.1 File Menu 
The following options are available on the File menu:  

• Open Report File – open a saved report file. 

• Server names – select the OnTraQ server from the list of server names 
displayed here. You may log into multiple servers at the same time. The list of 
servers available depends on your access rights.  If your system includes 
redundant servers to optimize availability, only log into one server at a time.  If 
the primary server fails, log out and log into redundant server.  

• Configure OnTraQ Servers – this displays the OnTraQ Servers window. You can 
select a server from this window and edit the information that OnTraQ uses to 
connect to that server. Note that this is restricted to administrative users.   

• Logout – logs you out of OnTraQ but does not close OnTraQ. 

• Exit – logs you out of OnTraQ and also closes OnTraQ.  

4.2 Edit Menu 
The following options are available on the Edit menu:  

• Copy – allows you to copy an object in OnTraQ (if that object can be copied). 

• Paste – allows you to paste copied information or an object (if that action is 
allowed). 

• Rename – allows you to rename an object (if renaming is allowed).  

4.3 View Menu 
The following options are available on the View menu: 

• Change Alarm Colors/Sounds – allows you to change the color-coding and 
sounds used for alarms. 

• Small, Medium, and Large Fonts – allows you to select the size of the font 
OnTraQ uses. 

4.4 Tools Menu 
The following options are available on the Tools menu: 

• Report Templates – displays the Report Template pane and allows you to 
create new report folders and delete report templates.  Note that only 
Administrative users may create folders for Shared Templates.  All users may 
create folders for their Personal report templates.   

• Scheduled Activities – displays the Scheduled Activities pane and lets you 
create new scheduled activities and delete or make inactive currently 
scheduled activities.  (See Section 3.10.5.4 for more details.) 
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• ACD Object Access – Select OnTraQ users and limit their ability to view objects 
in OnTraQ. For example, you can limit a shift leader’s view to his or her agents 
only. This option is for administrative users only. Other users will not see it as a 
menu option.  

• Alarm Thresholds – Define the alarm thresholds for Service Groups and Agents, 
including all Service Groups or individual ones. You can also use the Clear All 
Entries option to erase the current thresholds for an Agent or Service Group. 
(See Section 3.4 for more details.) 

• ANI/DNIS Group – Define rules that associate calls with appropriate ANI/DNIS 
groups. This option is for administrative users only. Other users will not see it 
as a menu option. 

• OnTraQ Servers – Define the server properties that OnTraQ uses to retrieve 
information from the Traffic Analyst database. 

• System Preferences – Define your Session Boundaries (these typically 
correspond to your workshifts), the Time-In-Queue-Bands (the boundaries that 
define a queue, the Data Storage Timeframes for the Life of Call and Event 
Logs, Direct Call Categories, Object monitoring for Precision Queues, and the 
URL location of the Traffic Analyst database, which OnTraQ needs to have to 
collect switch data.  

• Custom Agent States – Define custom states for your agents. This option is for 
administrative users only. (See Section 2.9 for more details.) 

• Audit Log – View when your users have logged in and out of the system. You 
can filter by date and user.  

4.5 Window Menu 
The following options are available on the Window menu: 

• Agent Team Explorer – displays the Agent Team Explorer 

• Service Group Explorer - displays the Service Group Explorer 

• Service Group Status – displays the Service Group Status pane, which displays 
real-time statistics for your Service Groups 

• Close Window Layout – this closes all the OnTraQ panes.  

• Default Window Layout – this reverts to the default OnTraQ layout. 

• Save Window Layout – this saves your current layout. Whenever you login to 
OnTraQ the saved layout is automatically displayed. 
 
Note: Multiple historical reports cannot be saved to the window layout. 

• [any open panes] – if you have any other panes open those panes will be listed 
here. Click on one to bring it to the front of the OnTraQ Dashboard.  

4.6 Help Menu 
The following options are available on the Help menu 

• OnTraQ Help… – displays a web link to OnTraQ documentation. 

• About OnTraQ… – displays software version information about OnTraQ. 
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